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Follow the steps in this document to create, manage, and backup Outlook Personal Folders (.pst files). Your .pst 

file contains local Outlook folders, such as Calendar, Inbox, Tasks, Sent Items, Outbox, Deleted Items, and 

user-created folders. 
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Storing Outlook Files 

Store Outlook messages, contacts, appointments, tasks, notes, and journal entries in one of the following two 

locations: 

Outlook 

Mailbox 

Information in your mailbox is stored in your user account on the Exchange server (see 

Mailbox - jdoe in the example at right). Most Outlook mailboxes have a limited size of 1 GB. 

If the mailbox size reaches 990 MB, you will receive notifications that your mailbox needs to 

be decreased. If the mailbox size reaches 1 GB, you will still receive e-mail messages, but you 

will not be able send e-mail messages. Visit the Mailbox Management page for more 

information: http://itcd.hq.nasa.gov/mailbox_management.html 

Personal 

Folders 

(.pst files) 

Information in your Personal Folders (.pst files) are stored locally on your computer (e.g., not 

on the Exchange server).  Files in these folders do not count against your server limit.  

However, it is recommend that you keep .pst files under 20GB. 

 

 

The Importance of Using PST Files 

There are many benefits to working with .pst files: 

 

Faster and Better Performance 

A large mailbox size can result in slow response times when opening Outlook, and 

sorting and/or searching files. Therefore, when you create Personal Folders (.pst 

files), such as the folder called 3.27.14 in the example at right, you can move items 

from your Outlook mailbox (on the server) into a .pst file on your local hard drive, 

thereby reducing the size of your Outlook mailbox, which improves performance.  

  

Backup Protection 

Once you move Outlook data into a .pst file, as long as you are connected to the 

NASA network, these files are backed up regularly by Mobile Information 

Protection (MIP) during your scheduled backup. 

Important!  
If the .pst file is larger than 20 GB, it will not be backed up. See Check PST 

File Size for steps. If your .pst file is over 20 GB, split it into smaller files. See 

Create PST File for steps. 

 

For additional protection, you can also choose to manually back up your .pst file on a regular basis. The Back 

up PST Files by Exporting section describes this process. The size of your .pst file and the frequency with 

which you perform incremental backups determine the length of time it will take for the backup to complete. 

More frequent incremental backups reduce the length of time needed for each backup to run. 

 

http://itcd.hq.nasa.gov/mailbox_management.html
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Mobility 

If you would like to import the .pst file to another Outlook client on a different machine, or use the Outlook 

contacts on another e-mail client or another computer, you need to first back up the .pst file.  

Important! 

Opening a .pst backup file from the network file share (T:\drive) could corrupt the backup file and you 

could lose data in the .pst file. If you need to access the file, follow the steps for Open .PST Backup Files. 

 

PST Flowchart 

The following sections of this document detail each part of the PST process, as illustrated below.  
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Create PST File 

You can create a .pst file with unique folders and subfolders to your preferences. There are differences between 

an Archive and a .pst file. An archive exactly mirrors the mailbox, has all the same folders, and the Auto 

Archive processing, when enabled, automatically moves messages based on the Auto Archive settings. With a 

.pst file, on the other hand, you manually maintain it. It is more flexible in design and can be customized to your 

preferences. To create a .pst file: 

1. Click the Home tab | New Items | More Items | Outlook Data File, as shown right. 

The Create or Open Outlook Data File window displays (shown below) 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. In the File name text box, type the .pst file name and then click OK. 

 Very large .pst files can become corrupt. Using multiple .pst files for unique projects or by year is 

recommended. In the example above, the .pst file is given the name 3.27.14. This can be a reminder 

to the user that a new .pst file should be created on 3.27.15.  

 .pst files are not accessible through Webmail (OWA) 
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Create PST File Subfolders 

Once you’ve created a .pst file, start creating subfolders for it. These are the folders you will use to store your 

Outlook information, such as e-mails. You can create as many subfolders as you need, and name them whatever 

you wish. To create a .pst file subfolder: 

1. In the Outlook Navigation pane, right-click on the .pst file you just 

created | Select New folder  

2. When the text box appears, enter a name for the new .pst subfolder | 

Press Enter. 

 
3. The new subfolder is created and visible in the Outlook Navigation pane. 

4. Click the triangle in front of the .pst file  to display the 

subfolder. 

 

Move Outlook Data into PST File 

The process of moving Outlook data into your .pst file is a continuous one. In the course of your day, as you 

work in Outlook, you can move previously viewed e-mails into the .pst file subfolders you created in the 

previous step. There are various methods for moving data into your newly created .pst file subfolders: 

 Select the item you wish to store in a .pst file, such as an e-mail, 

and drag it into the specific .pst file subfolder (shown right). 

 To move an e-mail message while it is still open, right-click on 

the item | Select Move | Select the desired folder if listed.  

If the desired folder is not listed, click Other Folder | When the 

Move Items window displays, select the correct folder location  | 

Click OK. 

 Create rules to move items automatically. For more information, 

documentation on Rules and Filters is available at 

http://nomadinternal.nasa.gov/nomad/documentation.html 
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Check PST File Size 

As very large .pst files can become corrupt, and .pst files over 20 GB will not be backed up, you may want to 

monitor the size. To check the size of your .pst file: 

1. Right-click on the .pst file you just created | Select Data 

File Properties. 

2. On the .pst Properties window, on the General tab, click 

Folder Size. 

3. Look at the number next to Total size (including 

subfolders): and reference the chart at right to ensure it is 

less than 20 GB. 

 

Back up PST Files by Exporting 

Since your .pst files are periodically backed up throughout the day by Mobile Information Protection (MIP), a 

Connected Backup Agent, they are protected. However, if you choose, you can also back up your .pst files by 

exporting them to your T drive. More frequent incremental backups reduce the length of time needed for each 

backup to run. A good practice is to set up a recurring calendar reminder to back up weekly. To back up your 

.pst files by exporting, follow these steps: 

1. Click File | Open & Export | Import/Export.  

2. When the Import and Export wizard begins, select 

Export to a file | Click Next. 

3. When the Export to a File window appears, select 

Outlook Data File (.pst) | Click Next. 

4. When the Export Outlook Data File window 

appears, scroll to and select the .pst file | Click the 

Include Subfolders checkbox if desired. | Click 

Next 

 

5. On the Export Outlook Data File window, specify the location to save your .pst file backup. 

It is recommended that you save the backup .pst file to your T:\drive. If you back up often, the last 

location and .pst backup file name should already be there. You can just change the .pst backup file 

name. E.g., For “T:\Backup.PST\07.05.13 backup.pst” you would change the “07.05.13” to the current 

date.   
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6. Under Options, select Replace duplicates with items exported | Click Finish. 

If you choose to back up on a regular basis, it is recommended you overwrite the previous backup file. 

This option ensures that only changed or new items are added with each backup. 

7. Select the desired password protection. 

As the recommended backup .pst file storage location is your T:\drive on the server (see step 5), a 

password is unnecessary. If you create a password and then forget it, you will not be able to access the 

backup .pst file in the future. 

 

8. Click OK to dismiss the Password window and begin 

the export process.  

While the export is running, you will not be able to do 

anything in Outlook until it completes. 

 

 

Open PST Backup Files 

Opening a .pst backup file from the network file share (T:\drive) could corrupt the backup file and you could 

lose data in the .pst file. If you need to access the file, follow these steps:  

1. Copy it to this location:      C:\Users\YourUserName\Documents\Outlook Files 

2. Click File | Open & Export | Open Outlook Data File. 

3. When the Open Outlook Data File window displays, select the .pst backup file and click Open.  

The .pst backup file displays in the Outlook Navigation pane. 

 

Find Name and Location of PST Files 

To identify the name and location of your .pst file, open Outlook 2013 and follow the steps 

below:  

1. Click the File tab | From the left, select Info.   

2. Click Account Settings | Select Account Settings.  
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3. Click the Data Files tab. Note the path 

and file name of your .pst file. For 

Name and Location.  

For Example, C:\Exchange\Mailbox.pst 

indicates a .pst file that is named 

Mailbox.pst located in the Exchange 

folder on your drive C.  

 

4. Click Close.  

5. Follow the steps in the next section to 

adjust your settings to ensure all files 

and folders are visible. 

 

 

Show Hidden Files and Folders 

Once you know the file path of your PST file, make sure your computer is set up to show hidden files and 

folders in order to locate and copy your file to a new location. 

 

 

1. Click the Start button |Control Panel | Folder 

Options.   

2. Click the View tab.  

3. Under Advanced Settings, click Show hidden 

files and folders, and drives | Click OK. 
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Import PST Files to another Outlook Client or Different Computer 

If you would like to import the .pst file to another Outlook client on a different machine, you must first back up 

the .pst file, and then follow the steps below: 

1. Copy it to this location:  C:\Users\YourUserName\Documents\Outlook Files 

2. Click File | Open & Export | Open Outlook Data File. 

3. When the Open Outlook Data File window displays, select the .pst backup file and click Open.  

The .pst backup file displays in the Outlook Navigation pane. 

Import Outlook Contacts to Other E-mail Client, Computer, or Program 

You can export your Outlook contacts as a .pst file that can then be imported into another e-mail client, 

computer, or program.   

Export Outlook Contacts 

To export your Outlook contacts as a .pst file: 

1. Click File | Open & Export | Import/Export. 

2. When the Import and Export wizard begins, select 

Export to a file | Click Next. 

3. When the Export to a File window appears, select 

Outlook Data File (.pst) | Click Next. 

4. On the Export Outlook Data File window, under 

Select folder to export from, select the Contacts 

folder | Click the Include Subfolders checkbox if 

desired | Click Next.  

5. On the Export Outlook Data File window, specify the 

location to save your .pst file backup. 

 

It is recommended that you save the Contacts backup .pst file to your T:\drive. 

6. Under Options, select Replace duplicates with items exported | Click Finish. 

7. Select the desired password protection. 

As the recommended backup .pst file storage location is your T:\drive on the server (see step 5), 

a password is unnecessary. If you create a password and then forget it, you will not be able to 

access the backup .pst file in the future. 

8. Click OK to dismiss the Password window and begin the export process. 

While the export is running, you will not be able to do anything in Outlook until it completes. 

You can now import the Outlook Contacts .pst file you just created into another Outlook e-mail client, 

as described in the next section. 
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Import Outlook Contacts 

After you export Outlook contacts as a .pst file, you can then import them into another Outlook e-mail client: 

1. Click File | Open & Export | Import/Export. 

2. When the Import and Export wizard begins, select Import from another program or file | Click 

Next. 

3. When the Import a File window appears, select Outlook Data File (.pst) | Click Next. 

4. On the Import Outlook Data File window, under File to import, browse to and select the contacts .pst 

you created in the section above | Click Next. 

5. Under Options, select Replace duplicates with items exported | Click Next. 

6. In the Import a File window, under Select destination folder, click a folder for the imported contacts | 

Click OK. 

This usually is the Contacts folder unless you have multiple accounts, or have created multiple 

contact folders for an account. 

 

7. Click Finish to begin the import process. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For assistance, contact the Enterprise Service Desk (ESD): Submit a ticket online at esd.nasa.gov, or call 358-

HELP (4357) or 1-866-4NASAHQ (462-7247). 

 

This document is posted on the ITCD Web site at: 

http://itcd.hq.nasa.gov/instructions.html 

https://esd.nasa.gov/
http://itcd.hq.nasa.gov/instructions.html

